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1 Introduction
This manual describes the IBM® Rational® Team Webtop™ tool. The Rational 
Team Webtop is a powerful centralized solution, that allows users to access the 
data stored under IBM® Rational® DOORS®, IBM® Rational® Tau® and 
IBM® Rational® Change tools from one place. 
This chapter contains the following sections:

•  About Rational Team Webtop

•  Key Webtop features

•  Contacting IBM Rational Software Support

•  Conventions used in this Guide

About Rational Team Webtop
Rational Team Webtop is an exemplary implementation of a browser based 
composite application built on Rational Change, Tau, DOORS and IBM® 
Rational® Harmony™. Webtop provides a single point of entry and User 
Interface (UI) for users to access relevant application lifecycle data, regardless of 
where that data is held. 
Webtop is staged as a state of the art reviewing tool, that help users to effectively 
carry out their review activities for the different stages of the application lifecycle 
data residing under disparate repositories, (For example, requirement data 
(DOORS), Design data (Tau) from within Webtop. 
Webtop aims to replace the current solution, where, users in order to access 
application lifecycle data that spans multiple disciplines, are required to use 
multiple tools, with different user interfaces, integrated through a set of point to 
point integrations.

Key Webtop features
Rational Team Webtop is a web-based tool that primarily allows users to perform 
tasks such as create new projects, add roles to users, view project data, review 
project data, create external links, add comments, etc.
This section describes the following primary features of Webtop. 

•  Projects

•  Review data
IBM Rational Team Webtop Product Manual 1



Chapter 1: Introduction
•  External relationships

•  Process guidance

•  Roles

Projects
The projects feature enables aggregation of data from disparate repositories, 
thereby bringing together multiple tools within Webtop. The project consists of a 
single Change database and a set of DOORS and Tau projects. These projects are 
selected at the time of a project creation. For more information on creating a 
project, see Create new project (page 9).

Review data
The reviewing feature allows users to review the data stored under multiple 
disparate repositories such as DOORS, Change and Tau, and raise a work item or 
change request against any object for the defects, or any suggestions found at the 
time of a review.

External relationships

The External Relationships (ER) is a powerful feature of Webtop, that essentially 
means linking objects between different repositories (for example, linking 
Requirements (DOORS) and Design data (Tau). However, the current release of 
Webtop supports only creating a link between an object from any repository and 
a change request. For more information on creating ER see, Creating an external 
relationship (page 29).

Roles
The identity a user assumes is called a role. The Webtop provides set of roles that 
can be assigned to users. A role essentially describes the set of tasks a person is 
allowed to perform.

Process guidance
The process guidance basically guides the user on what process to use or what 
step to follow next in a process, etc. The processes are available under the tool 
called Rational Harmony. The Webtop allows you to connect to this tool using a 
URL. For more information on the process guidance see, Using Process 
Guidance (page 36).
2 IBM Rational Team Webtop Product Manual



Contacting IBM Rational Software Support
Note  This tool is not packaged along with the Webtop. The user 
needs to purchase this tool separately in order to use this 
feature.

Contacting IBM Rational Software Support
If the self-help resources have not provided a resolution to your problem, you 
can contact IBM® Rational® Software Support for assistance in resolving 
product issues.

Note  If you are a heritage Telelogic customer, a single reference 
site for all support resources is located at http://
www.ibm.com/software/rational/support/telelogic/

Prerequisites
To submit your problem to IBM Rational Software Support, you must have an 
active Passport Advantage® software maintenance agreement. Passport 
Advantage is the IBM comprehensive software licensing and software 
maintenance (product upgrades and technical support) offering. You can enroll 
online in Passport Advantage from http://www.ibm.com/software/lotus/
passportadvantage/howtoenroll.html

• To learn more about Passport Advantage, visit the Passport Advantage 
FAQs at http://www.ibm.com/software/lotus/passportadvantage/
brochures_faqs_quickguides.html.

• For further assistance, contact your IBM representative.

To submit your problem online (from the IBM Web site) to IBM Rational 
Software Support, you must additionally:

• Be a registered user on the IBM Rational Software Support Web site. For 
details about registering, go to http://www.ibm.com/software/support/.

• Be listed as an authorized caller in the service request tool.

Submitting problems
To submit your problem to IBM Rational Software Support:

1. Determine the business impact of your problem. When you report a 
problem to IBM, you are asked to supply a severity level. Therefore, you 
need to understand and assess the business impact of the problem that you 
are reporting.
IBM Rational Team Webtop Product Manual  3
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Chapter 1: Introduction
Use the following table to determine the severity level.

2. Describe your problem and gather background information, When 
describing a problem to IBM, be as specific as possible. Include all relevant 
background information so that IBM Rational Software Support specialists 
can help you solve the problem efficiently. To save time, know the answers to 
these questions:

• What software versions were you running when the problem occurred?

To determine the exact product name and version, use the option 
applicable to you: 
• Start the IBM Installation Manager and select File > View Installed 

Packages. Expand a package group and select a package to see the 
package name and version number. 

• Start your product, and click Help > About to see the offering name and 
version number. 

• What is your operating system and version number (including any 
service packs or patches)? 

• Do you have logs, traces, and messages that are related to the problem 
symptoms? 

• Can you recreate the problem? If so, what steps do you perform to 
recreate the problem? 

Severity Description

1
The problem has a critical business impact: You are unable to 
use the program, resulting in a critical impact on operations. 
This condition requires an immediate solution.

2 This problem has a significant business impact: The program 
is usable, but it is severely limited.

3
The problem has some business impact: The program is 
usable, but less significant features (not critical to 
operations) are unavailable.

 4
The problem has minimal business impact: The problem 
causes little impact on operations or a reasonable 
circumvention to the problem was implemented.
4 IBM Rational Team Webtop Product Manual



Submitting problems
• Did you make any changes to the system? For example, did you make 
changes to the hardware, operating system, networking software, or 
other system components? 

• Are you currently using a workaround for the problem? If so, be 
prepared to describe the workaround when you report the problem.

3. Submit your problem to IBM Rational Software Support. You can submit 
your problem to IBM Rational Software Support in the following ways:

• Online: Go to the IBM Rational Software Support Web site at https://
www.ibm.com/software/rational/support/ and in the Rational support 
task navigator, click Open Service Request. Select the electronic 
problem reporting tool, and open a Problem Management Record 
(PMR), describing the problem accurately in your own words.

For more information about opening a service request, go to http://
www.ibm.com/software/support/help.html

You can also open an online service request using the IBM Support 
Assistant. For more information, go to http://www.ibm.com/software/
support/isa/faq.html.

• By phone: For the phone number to call in your country or region, go 
to the IBM directory of worldwide contacts at http://www.ibm.com/
planetwide/ and click the name of your country or geographic region. 

• Through your IBM Representative: If you cannot access IBM 
Rational Software Support online or by phone, contact your IBM 
Representative. If necessary, your IBM Representative can open a 
service request for you. You can find complete contact information for 
each country at http://www.ibm.com/planetwide/.
IBM Rational Team Webtop Product Manual  5
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Chapter 1: Introduction
Conventions used in this Guide

Typeface Description

Italic Used for book titles and terminology.

Bold Used for items that you can select and menu paths, also 
used for emphasis.

Courier Used for commands, file names, and directory paths.
Represents command syntax to be entered verbatim. 
Signifies computer output that displays on-screen.
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2 Webtop administration
The Webtop administration allows the administrators to carry out the 
administrative tasks such as creating new projects, managing users, providing 
access to the users etc. 
This chapter contains the following sections: 

•  How the RLS tools information is displayed

•  Create new project 

•  Manage users

•  About Roles

Note  The Administration menu appears disabled for the 
normal users. Only the users with the administrator 
privileges have this option enabled. 

How the RLS tools information is displayed
The Webtop is configured to a IBM® Rational® Directory Server (RDS) 
instance, which acts like a central repository. The IBM® Rational® Solutions for 
Enterprise Lifecycle Management (RLS) applications that are registered with RDS 
are fetched and listed in the Webtop. 

Starting Rational Team Webtop
When the Rational Team Webtop is started for the very first time, the user is 
presented with an extended login form, asking for the RDS details. The user must 
be a valid RLS user to logon to the Webtop. 
You can access the Rational Team Webtop through your browser.
To log on to Rational Team Webtop:

1. In your default browser, type the URL for the Rational Team Webtop.

For example:
http://examplehost:8080/webtop

The Welcome screen is displayed.
IBM Rational Team Webtop Product Manual 7



Chapter 2: Webtop administration
2. In the Welcome screen, type the following details.

Field name Description Example value

Username Administrator user. The 
user must be a valid RLS 
user.

admin

Password Password for the 
administrator user

pass123

RDS Location Host name or IP address 
of the server where RDS 
is running

RDSServer1
8 IBM Rational Team Webtop Product Manual



Administration menu
Note  If Is RDS Port SSL Enabled check box is checked and a 
non-SSL port number is provided in the RDS Port field, or 
if a SSL port number is given in the RDS Port field and the 
check box is not checked, the login will fail.

3. Click Submit.

Note  The next time the user logging on to this instance will have to 
provide only the user name and password for the Rational 
Team Webtop.
On successful login, the user automatically becomes the Webtop 
administrator. This also enables the administration menu for the 
administrator to perform all the administrative tasks.

Administration menu
The administration menu allows you create new projects and provide access to 
the users, using the New Project and Manage Users options.

Create new project
You can create new projects and provide access to the users for the projects. The 
New Project option contains two tabs: 

• Data Source - This tab allows you to provide the details for the new project. 

• Project Users - This tab allows you to provide access to the users. 

RDS Port RDS port number 1389

Is RDS Port SSL Enabled To enable SSL 
authentication

Check this option if you 
want to authenticate 
securely using SSL

Field name Description Example value
IBM Rational Team Webtop Product Manual  9



Chapter 2: Webtop administration
To create a new project:

1. Choose Administration > New Project. 

2. In the Project Name box, type the name for the new project.

3. In the Process Guidance Base URL box, type the base URL for the 
Rational Harmony repository. For example, http://harmony:1234. This 
field enables the users to access the Harmony repository to view the process 
guidance. For more information on the process guidance see, Using Process 
Guidance (page 36).

4. Under Project Data, select Change. In the Change Repository box, select 
the change repository from the list.

Notice that the Role to login with the list of roles and the Initial State 
options are enabled, as soon as you selected the change repository. These are 
the user defined roles and initial state of the work item in the Change tool, 
that are listed here. You can assign these roles and work item state to the 
users for the selected change repository.

5. In the Role to login list, select the role from the list. 

Webtop accesses the information in Change using this role.

6. In the Initial State list, select the state from the list.

Initial state is the state to which a newly created work item would be 
transitioned to.

7. Under Project Data, select DOORS. In the DOORS Repository box, 
select the DOORS repository from the list.

The list of DOORS projects for the selected repository are listed under the 
Included DOORS Project box. 

8. Select a DOORS project by clicking the check box next to the project. You 
can select multiple DOORS projects.

9. Under Project Data, select Tau. In the Included Tau Project box, select a 
Tau repository. 
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Create new project
You can select multiple repositories. Select a Tau project or a Tau package to 
be included as part of Webtop Project definition.

Note  In Tau, the projects are referred as repositories.

10. Click the check box next to This project is my default project to make the 
project a default project.

This causes the project to open automatically, when the user logs in next 
time. 

To provide access to users:

1. Click the Project Users tab.

2. Select the users from the Available Users list box and click Add to 
Managers to grant user a manager role or click Add to Reviewers to grant 
user a normal user or reviewer role.
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3. Click OK.

4. To remove the users, select the user and click Remove.

Manage users
The Manage users option allows the administrator to add users as admin users, 
project managers, and project users. The users added as admin users have the 
administrator privileges to carry out all administration tasks.
To add users as admin users and project users:

1. Under the Admin Users tab, select the users from the Available Users list 
box and click Add to Admin.
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Manage users
2. Click OK.

3. Click the Project Users tab.

4. Under Project Users tab, select the users from the Available Users list box 
and click Add to Managers or Add to Reviewers.
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Projects menu
The project menu allows you to:

• Perform various activities such as open, edit, delete projects, etc. using the 
View Projects option.

• Set the open project as a default project using the Set as default option.

View Projects

The view projects option allows you to view, open, edit, delete, create new 
projects, and set the project as default project.
To perform the above mentioned activities:

1. In the Projects menu, click View Projects.

The View Projects dialog box appears with the list of existing projects.

2. To open the project, select the project and click Open.

3. To edit the project, select the project and click Edit. 
14 IBM Rational Team Webtop Product Manual



About Roles
The Edit Project dialog box appears. Modify the details in the Edit Project 
dialog box and click OK. For more information on the details see, Create 
new project (page 9).

4. To delete the project: 

• In the view projects dialog box, select the project and click Delete.
• The message box appears. Click OK in the message box.

5. To set the project as default project: 

• In the view projects dialog box, select the project and click Set as 
Default.

6. To create a new project, click New.

Type the details for the new project. For more information on creating a 
new project see, Create new project (page 9).

7. Click OK.

8. Click Close to exit the View Projects dialog box.

About Roles
Roles are assigned to users, and a user can have more than one role. For example, 
a user can be a both Reviewer and a Manager.
The following are the pre-defined roles:

• Admin Users

• Project Managers

• Project Users
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The following table describes the pre-defined roles:

Roles Capabilities

Admin Users Allows the users to carry out all the administrative 
tasks such as creating, editing projects, providing 
access to users, adding process guidance etc. 
The administrator can also choose to assign other 
users the administrator role, thereby allowing 
them to perform minimal administrative tasks 
such as creating projects, editing projects etc.

Project Managers Allows the user to perform certain administrator 
tasks such as creating project, editing project, etc. 
along with the other normal tasks such as 
opening existing projects, performing reviews, 
etc.

Project Users Allows read-only access to the users. The users 
can open the projects assigned to them, and 
perform the reviews.
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3 Webtop interface overview
This chapter provides you the information about the Webtop interface. The 
Webtop interface is divided into the following sections:

• Navigation panel

• Details panel

• Recent Documents panel

• Workarea panel

• About Views

The following diagram displays the complete Webtop interface:
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Navigation panel
The navigation panel is organized into two sections:

• Work Items tab

• Artifacts tab

Work Items tab

The Work Items tab displays all the work items raised by the users and the links 
created between the objects. For more information on work items see, Working 
with Work Items (page27).

Artifacts tab
The artifacts tab displays the information from the RLS applications such as 
DOORS and Tau. You can access these applications from Rational Team Webtop 
to perform your day-to-day tasks such as reviewing, raising a work item, initiating 
a discussion, etc. 
For example, you can perform a review task on one of the system requirement 
documents and raise a work item for the defects found or any suggestions on the 
enhancements in the document.

Details panel
The Details panel contains two sections with information about the currently 
selected object (project, folder, module, and so on). The Details panel is 
organized into three separate sections:

• Attributes tab

• Discussions tab

• Links tab

Attributes tab
The Attributes tab contains information about the attributes that apply to the 
current DOORS and Tau objects. The attributes define the features of the 
selected object. All of an object’s attributes are read-only.

Discussions tab

The Discussions tab contains information about the discussions that apply to the 
current DOORS object. Discussions allows reviewers to exchange views about 
the content of a module or an object within the module or object itself. 
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Recent Documents panel
You can maintain running discussions about objects and modules of the 
DOORS. The discussions are presented to you in the Discussions tab of the 
Details Panel.
Objects with discussions have a Discussion icon in the discussion column. 
You can create, view, modify and close discussions for modules and for objects 

Links tab
Links provide improved understanding of the changes and easier determination 
of the impact of a changed information across various stages of the application 
lifecycle data. You can follow these links by simply clicking them.
The links tab shows two types of links:

• External link - shows the related external relationship between the object 
from one repository to the other. The external relationships essentially 
means linking objects between different repositories.

For example, when a work item is raised, you can find out which 
requirements are affected by tracing the link from the work item to the 
requirement document, and from requirement document to the work item. 
For more information on external relationships see, Working with External 
Relationship (page28).

The following diagram shows the example of the external link:

• Native link - shows the related relationship between objects within the 
same repository. For more information on native links see, Opening objects 
in native client (page32).

Recent Documents panel
This section is organized into the following:

• Recent Documents

• Favorites Documents

Work Item 
(Change) 

Requirements 
(DOORS) 

Class Diagram 
(TAU) 

Work Item 
(Change) 

ER2ER1

ER3
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Recent Documents
Whenever you open the object, it is added to the recent item list. This help you to 
track the recently opened objects.

Favorites Documents

If you use certain objects regularly, you can add them to your favorites list. 
Instead of navigating through the database hierarchy to access the object, you can 
open it from your favorites list.
The favorites list is displayed below the Artifacts Explorer:

Workarea panel
The Workarea panel displays the contents of the objects along with the 
related icons and options. You can use the icons and options to access 
various information such as the process guidance, external links, etc. for the 
opened object. 
20 IBM Rational Team Webtop Product Manual



About Views
The following screen shot displays the sample workarea with the related 
icons and options for the DOORS object.

About Views
The views show the complete or part of the component. The views allow you to 
navigate through different types of information. In Webtop, each view is 
displayed in a tree like structure. The Webtop views are organized into two 
separate views:

• Project View

• Global View
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Project View
This view displays all the existing projects and its objects. This view lets you 
navigate through the projects and see the objects of that project. 

Global View
The global view is basically a repository view. This view displays the entire tree of 
the repository. For example, the DOORS repository along with all the 
components of that repository.

Note  You can set these projects and repository as a root project or 
repository to view only the components you need to work 
with. For more information on setting as the root see, Setting 
as root (page23).
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Setting as root
To set the project as root:

In Project View or Global View, select the project or repository and click 
the arrow icon displayed in the right side of the Project or Global View. 
This will make the object as a root objects, cutting down the tree to only 
show the selected object.
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4 Getting started
This chapter describes each feature in detail to help you get started withe Webtop. 
This chapter contains the following sections:

• Working with Artifacts 

• Working with Work Items

• Working with External Relationship

• Using Discussions

• Using Process Guidance

• Using Favorite Documents

Working with Artifacts
You can access the artifacts to carry out your tasks such as reviewing, raising work 
items, etc. For more information on artifacts see, Artifacts tab (page 18).
To work with the artifacts, see:

• Open Artifacts

• Display Artifacts

Open Artifacts
To open an artifact:

1. In the Artifacts tab, expand the artifact by clicking the plus sign  displayed 
against the artifact.

2. Right-click an object under the artifact, click Open and then click Open or 
drag the artifact into the Workarea panel.
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You can also click New bottom or New right options to display the 
contents at the desired frame.

If the object is the database root, a project, or a folder, its contents are 
displayed in the Artifacts Explorer, and its properties are displayed in the 
attributes section of the Details Panel.

Display Artifacts

When you open a artifact in Artifacts tab, it opens in its default view. You can 
open up to four artifacts at the one time.
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Working with Work Items
You can control the way artifacts are displayed using the Layout menu.

Working with Work Items
The work items or change requests are basically a problem report that tracks the 
defects or the enhancement requests raised by the reviewers. The user can assign 
a work item to an object residing under different repositories.
The Webtop allows you to:

• Raise a work item

• Filter work items

Raise a work item

To raise a work item:

1. In the Work Items tab, right-click and select Raise Work item or click 
New. 

The New Work Item form is opened in the Artifacts Explorer.
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2. Type the details for the work item and click Submit.
The work item is created.

Filter work items
You can filter the work items based on their status and particular user. 
To filter the work item:

1. In the Work Items tab, click the Iteration list box, and select the option 
from the list. 

The work items as per your selected criteria is listed. By default, the Work 
Items tab displays All Iterations.

2. In the Work Items tab, click the Assigned to list box, and select the user 
name from the list.

The work items assigned to the selected user is listed.

Working with External Relationship
With external relationship, you can create a link between the object and a work 
item, view the linked object, open the linked objects in Webtop and open the 
objects in the native client. 
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Creating an external relationship
You can create a link in two ways. 
To link an object, do one of the following:

1. In the Artifacts tab, right-click the object and click Raise Work Item. 

The New Work Item form is opened in the Artifacts Explorer. 

2. Type the details for the work item and click Submit.
Notice that the link icon is assigned to the object and the related work 
item.

3. In the Artifacts tab, right-click the object, select Start Relationship.

4. Go to the Work Items tab, right-click the work item and then click Make 
Relationship.
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The link is created between the object and the work item and the link icon is 
displayed in front of the object and the work item.

Viewing an external relationship link

You can view the external relationship for an work item or for an object. For 
example, you can open the link attached to the work item to view the object that 
is linked with the work item or you can open the link attached to the object to 
view the related work item raised for this particular object.
To view the external relationship, do one of the following:

1. In the Work Items tab, click the External Relationship  icon.

The related object is opened in the Artifacts Explorer.

2. With the object opened in the Artifacts tab, click External Relationship  
icon displayed against the item in an object.

3. In the Artifacts Explorer, select the item in the object.

4. In the Links tab, click External Relationship and then click Follow.
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The related work item is opened in the Artifacts Explorer.

Unlinking the objects
To unlink the objects, do the following:

1. Open the object in the Artifacts tab, select the item that has a link.

2. In the Links tab, click Unlink.

OR

3. In the Work Items tab, select the work item and from the Links tab, click 
Unlink.
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The link is removed from the selected work item.

Opening objects in native client
You can open the objects in the native client (For example, DOORS or Tau). For 
this, the respective application must be installed in the same machine where the 
Webtop is installed. The change requests are automatically opened in the native 
client and they do not need any separate installation.

Opening Work Items

To open the Change Requests in native client:

1. With object opened in the Artifacts Explorer, right-click and then click Show 
in Native Client.

2. In the Work Items tab, right-click the work item and click Show in Native 
Client.
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Opening Tau objects
To open the Tau objects in native client:

1. With object opened in the Workarea panel, click the native link icon.

You are prompted to choose an application to open the object.

2. In the Launch Application dialog box, click Choose and select the Tau 
Native Client.

You are prompted to register the Uniform Resource Name (URN). This 
essentially means pointing to a directory where the Tau project files are 
located on the local hard disk.

3. In the Browse For Folder dialog box, select the directory path for the Tau 
object. 

4. Click OK.

The selected object is opened in the native client.

Opening DOORS objects
To open the DOORS objects in native client:

1. With object opened in the Workarea panel, click the native link icon.

2. Click OK.

The selected object is opened in the native client.

Using Discussions
You can create, view, modify and close discussions for modules and for objects 
in modules. Currently, the Discussions can be raised only for the DOORS 
projects. 

Create a discussion

To create a module or object discussion:

1. With the module closed, select it in the Artifacts Explorer, select the 
Discussions tab in the Details Panel, then click New.
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The New Discussion dialog box is displayed.

2. Type a summary and your comment.

3. Click Save.

The comment is saved and the discussion created.

View a discussion

To view a module discussion:

1. With the module closed, select it in the Artifacts Explorer, then select the 
Discussions tab in the Details Panel.

The discussions for the module are displayed. There are Open discussions 
and Closed discussions.

2. Expand the discussion you want to view.

The full discussion is displayed.

Add a comment to a discussion

To add a comment to a discussion:

1. With the module closed, select it in the Artifacts Explorer, then select the 
Discussions tab in the Details Panel.

The discussions for the module are displayed. There are Open discussions 
and Closed discussions.

2. Expand the discussion you want to add a comment to.

The full discussion is displayed.

3. Click New Comment within the discussion.
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The New Comment dialog box is displayed.

4. Type your comment and click Save.

The comment is added.

Close a discussion

To close a discussion:

1. With the module closed, select it in the Artifacts Explorer, then select the 
Discussions tab in the Details Panel.

2. The discussions for the module are displayed. There are Open discussions 
and Closed discussions.

3. Expand the Open discussion you want to close.

The full discussion is displayed.

4. Select Close.

The Change Status dialog box is displayed.

5. Type your comment and click Save.

The comment is added and the discussion is closed.

Reopen a discussion

To reopen a module discussion:

1. With the module closed, select it in the Artifacts Explorer, then select the 
Discussions tab in the Details Panel.

2. The discussions for the object are displayed. There are Open discussions 
and Closed discussions.

3. Expand the Closed discussion you want to reopen.

The full discussion is displayed.

4. Select Open, and enter a comment.

The Change Status dialog box is displayed.

5. Type your comment and click Save.

The comment is added and the discussion is reopened.
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Using Process Guidance
The process guidance allow the users to perform their tasks more effectively. You 
can use this feature from within Webtop, to get the help on the process that can 
be followed to complete a particular task. 
To use this feature, the administrator must:

a. Add the base URL at the time of project creation. 

b. Manually add the process guidance to an object by providing a relative 
URL.

The combination of a base URL and a relative URL provides a concrete link to 
the Process Guidance of an object. Once these two URLs are added by the 
administrator, the users with Project Manager or Project Users role can access the 
process guidance for a related object from the Webtop.

Note  To use this feature, the Rational Harmony tool must be 
installed.

Adding a process guidance

Before adding the process guidance, make sure that the base URL for the 
Rational Harmony tool is provided in the EPF Link box, at the time of creating 
the new project. This essentially enables the access to the Harmony tool from the 
Webtop. For more information on EPF Link see, Create new project (page 9). 
To add the process guidance:

1. In the Artifacts tab, right-click the object, select Guidance and then click 
Add Process Guidance. 

OR
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In the Work Items tab, right-click the work item and then click Add 
Process Guidance.

2. In the Add Guidance dialog box, type the relative URL for the process 
guidance. For example, http://harmony:1234/changeRequest.

Where, harmony is the host name, 1234 is the port number, and changeRequest is 
the object name.

3. Click Add.

The process guidance is added to the selected object.

Note  If process guidance is added for any change request, it is 
automatically applied for any other Change Request. 
However, for other objects, the administrator need to add the 
process guidance individually to the each object.

Open a process guidance
You can open the process guidance for a particular object, based on the URLs 
added by the administrator at the time of a project creation.
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To open the process guidance:

• In the Artifacts tab, right-click the object, select Guidance, and then click 
Process Guidance.

OR

• In the Work Items tab, right-click the work item and select Process 
Guidance. 

The Process Guidance is opened in a separate window.

Using Favorite Documents
You can use the favorites documents to access the objects that you use regularly. 
The Webtop allows you to:

• Add an object to the list of favorites

• Open an object from the list of favorites
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Add an object to the list of favorites
To add an object to your list of favorites:

1. Select the module in the Artifacts Explorer that you want to add to your 
Favorites.

2. Either:

• Right-click Add To Favorites.
• Drag the object into the Favorites area.

Open an object from the list of favorites
To open an object in your favorites list, either:

• Double-click it.

• Right-click Open > Open.
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5 Troubleshooting
This chapter describes the possible problems and solutions for Rational Team 
Webtop. 

Problems and Solutions
1. Webtop application is stuck or doesn't behave as expected while performing certain 

operations.

If you face any problem while performing certain tasks in Webtop, review the 
following error logs carefully for any errors.
• <WEBTOP-Home>\webtopServer\webtop.log 
• <WEBTOP-Home>\webtopServer\tauWebAccess.log 
• <WEBTOP-Home>\webtopServer\caf.log 
• <WEBTOP-Home>\webtopServer\change.log

The default log level is ERROR. Only the errors that occurred at the time of 
performing certain tasks are recorded in these files. 

You can change this log level to OFF, FATAL, ERROR, WARN, INFO, 
DEBUG etc. by manually editing the log4j.properties file found under:
• <WEBTOP-Home>\pyramidServer\webapps\webtop\

WEB-INF\classes\log4j.properties

• <WEBTOP-Home>\pyramidServer\webapps\change\

WEB-INF\classes\log4j.properties

• <WEBTOP-Home>\pyramidServer\webapps\caf\

WEB-INF\classes\log4j.properties

• <WEBTOP-Home>\pyramidServer\webapps\tau\

WEB-INF\classes\log4j.properties
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The content of the log files will be similar to the one given below (the 
highlighted ones are frequently used). The circled value shall be changed to 
ERROR, WARN, and DEBUG to get more information.

2. The user is able to see only few Change repositories in the drop down list and upon selecting 
the repository, the Roles and Entered states drop down list values dosen’t get populated, 
and the Webtop server (Tomcat) console prints the message “NotLoggedInException”. 

Try logging into Change with the same user credentials that was used for 
logging to Webtop.
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Appendix A: Notices
© Copyright 2000, 2009
U.S. Government Users Restricted Rights - Use, duplication, or disclosure 
restricted by GSA ADP Schedule Contract with IBM Corp.
This information was developed for products and services offered in the U.S.A. 
IBM may not offer the products, services, or features discussed in this document 
in other countries. Consult your local IBM representative for information on the 
products and services currently available in your area. Any reference to an IBM 
product, program, or service is not intended to state or imply that only that IBM 
product, program, or service may be used. Any functionally equivalent product, 
program, or service that does not infringe any IBM intellectual property right may 
be used instead. However, it is the user's responsibility to evaluate and verify the 
operation of any non-IBM product, program, or service. 
IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant you 
any license to these patents. You can send written license inquiries to: 

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A. 

For license inquiries regarding double-byte character set (DBCS) information, 
contact the IBM Intellectual Property Department in your country or send 
written inquiries to: 

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan 

The following paragraph does not apply to the United Kingdom or any other 
country where such provisions are inconsistent with local law: 
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INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES 
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
Some states do not allow disclaimer of express or implied warranties in certain 
transactions. Therefore, this statement may not apply to you. 
This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements 
and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 
Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of those 
Web sites. The materials at those Web sites are not part of the materials for this 
IBM product and use of those Web sites is at your own risk. 
IBM may use or distribute any of the information you supply in any way it 
believes appropriate without incurring any obligation to you. 
Licensees of this program who wish to have information about it for the purpose 
of enabling: (i) the exchange of information between independently created 
programs and other programs (including this one) and (ii) the mutual use of the 
information which has been exchanged, should contact: 

Intellectual Property Dept. for Rational Software
IBM Corporation
1 Rogers Street
Cambridge, Massachusetts 02142
U.S.A.

Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee. 
The licensed program described in this document and all licensed material 
available for it are provided by IBM under terms of the IBM Customer 
Agreement, IBM International Program License Agreement or any equivalent 
agreement between us. 
Any performance data contained herein was determined in a controlled 
environment. Therefore, the results obtained in other operating environments 
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may vary significantly. Some measurements may have been made on 
development-level systems and there is no guarantee that these measurements 
will be the same on generally available systems. Furthermore, some 
measurements may have been estimated through extrapolation. Actual results 
may vary. Users of this document should verify the applicable data for their 
specific environment. 
Information concerning non-IBM products was obtained from the suppliers of 
those products, their published announcements or other publicly available 
sources. IBM has not tested those products and cannot confirm the accuracy of 
performance, compatibility or any other claims related to non-IBM products. 
Questions on the capabilities of non-IBM products should be addressed to the 
suppliers of those products.
This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include the 
names of individuals, companies, brands, and products. All of these names are 
fictitious and any similarity to the names and addresses used by an actual 
business enterprise is entirely coincidental. 
If you are viewing this information softcopy, the photographs and color 
illustrations may not appear. 
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Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of 
International Business Machines Corp., registered in many jurisdictions 
worldwide. Other product and service names might be trademarks of IBM or 
other companies. A current list of IBM trademarks is available on the Web at 
www.ibm.com/legal/copytrade.html.

Netscape and Netscape Enterprise Server are registered trademarks of Netscape 
Communications Corporation in the United States and other countries.
Other company, product or service names may be trademarks or service marks of 
others.
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